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 What is it Theremin Synth?

This application is inspired by the musical instrument invented by Leon Theremin, called the Theremin, the
first electronic musical instrument, the father of all synthesizers.

This  software works  even  without  hardware,  you  can  download and  try  out  its  sounds.  You can send
commands and notes  from the software,  let  it  play with small  programs in Theremino Script,  connect
sensors, MIDI, to MaxMsp or any music system via Slot, UDP and OSC.

The  'extreme  efficiency  of  the  current  software,  makes  it  possible  to  generate  sounds  with  minimal
hardware. A master module and two CapSensor (or just one), are sufficient, for a total of about 60 Euro.

You can also start with a single CapSensor, spending less than 40 Euro, and then add modules, sensors and
capacitive buttons, to grow your own instrument without limits.

This software is also a test on how fast is becoming VBnet. The samples are generated one by one with
mathematical calculations in floating point at 44kHz stereo and are applied to all the normal effects of a
synth  OSCILLATORS, ADSR, FILTERS, LFO, and ECHO CHORUS. The result is a true polyphonic synthesizer,
but with a very low CPU consumption, practically almost zero, so that on a decent PC, you can run many
Theremin, playing simultaneously.

With  the  Theremino_Theremin we  tried  to  overcome the  limitations  of  the  original  Theremin,  in  the
following directions:

• Create voices richer than those that could be synthesized with hardware oscillators.

• Give the player the ability to "build"  tones more suited to his style of music.

• Facilitate the maintenance of the pitch, hooking the frequency to the nearest semitone.

• Arpeggios are possible, over chords sequences (like the famous "harmonic circle")

• Possibility of playing chords, as if they were a single note, changing their pitch

The  Theremino  Theremin  is  built  around two modules  CapSensor,  that  make  it  very  similar  to  a  real
Theremin (although more stable and linear). It can be played very well with a single antenna and fingers,
connecting it  to capacitive buttons and sliders  of  the  CapTouch type,  connected to all  modules of  the
system Theremino. 
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Theremin Synth

The operation modes

Theremin  Classic,  Similar  to  the original  Theremin instrument,  but  more flexible,  thanks  to  the digital
technology. To obtain the highest realism, we recommend to load the "Strings” preset.

Theremin Pizzicato This method intones the notes at 100% and automatically uses only the notes selected
by the "Range" and the currently selected chord. It is no longer possible to play out of tune, even if you
want, however, the possibility of changes and glides are limited. Tremolo and glissando are no longer
possible.

Poly  Retriggered With  this  method,  the  Theremin  is  completely  transformed,  a  becoming  a  classic
polyphonic synth, to be used with mechanical or capacitive keyboards. A keyboard can include three or four
ON/OFF buttons and can be extended up to 128 keys, for a total of more than 10 octaves, with "Velocity"
and "After touch".

Poly classic This method is even more similar to a classic polyphonic synth. Each time you press a key, the
note is triggered only once, to make better use of the classic ADSR envelope controls.

Radioactivity Almost  identical  to  the  previous  Polyphonic  mode,  but  optimized  for  the  Gamma
Spectrometry software, ThereminoMCA. Each note of the scale of the piano, is associated with certain
radiation energies, allowing to distinguish radioactive isotopes, from their sound.
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Required Hardware

Just connect a Master and two CapSensorHQ and the Theremin is ready!

To build the antennas,  you can use an electric wire,  a metallic  tube or any other object,  even as little
conductive as a banana, a glass of wine or a vase of flowers. 

It  is recommended to  divide pretty much the two antennas (at  least one meter,  to avoid interference
between the movements of the two hands) and to build the left antenna much larger than what you see in
these pictures.

It is not strictly necessary to make a classic Theremin with the classic two antennas setup, given that the
Theremin Synth, has a function of automatic "Staccato" and can be used with a single CapSensor, releasing
your left hand for other, easier to adjust controls, such as sliders and capacitive buttons.

With capacitive keys, you can "build" keyboards and musical instruments, never seen before. With sliders
you can adjust effects such as, for example, the filter of the sampler Theremino SoundPlayer, to get a good
WahWah effect. 

Possible  expansions  are  endless,  limit  is  only  in  the  number  of  controls,  that  you  can  handle  in  a
coordinated way. 

--------

Theremino System is not only a Theremin, but a complete system of Inputs Outputs, that makes possible
building musical instruments with "Inputs" of all kind, from magnetic fields, to light, webcams, pressure, up
to electrical resistance. See: www.theremino.com/hardware/inputs

The software is completely free and open source,  the latest version of the program is always available
here: www.theremino.com/downloads/multimedia

Attention:  To access  to the hardware of  Theremino system via USB, you must use the software HAL
(Hardware Abstraction Layer) as well, that can be downloaded here: www.theremino.com/downloads/
foundations

--------

Up to six sliders and capacitive buttons can be connected to the pins of the Theremino Master. 
You can start right away, with just a Master and a Cap sensor, spending less than 39 Euro. 
(www.theremino.com/contacts/ price-list)
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The main areas of the program

On the left, overall adjustments.

In the center, the list  of "Voices" and the "Chords" list.

To the right, adjustments to the single "Voice".

A keyboard, marks the notes you're playing and can be pressed with the mouse, to easily  test
sounds.

On top of the keyboard, two stripes indicate the signal coming from the volume and pitch antennas.

The piano-style keyboard, used in Polyphonic and Radioactivity modes, indicates the notes that are played
with an external keyboard and allows you, to try the sounds with the mouse, as well.

In Classic Theremin, Theremin Legato and Theremin Pizzicato, modes, to the normal keyboard, two strips
are added, marking the distance of the hand from the antenna with a filling of orange, indicating the note
you're playing and its volume.
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The general configuration
With this box you can choose the operation mode. These are explained, one by one, in the first page of this
document.

- Input slot of the note or the first slot of a group of notes. (Note 1)
- Minimum signal level to activate the notes.
- Volume input Slot.
- Negative Volume (Used in Theremin modes only) 

-Performance variations

- Frequency of data reading. (Note 2)
- Audio buffer length, in bytes. (Note 3)

(Note 1) In polyphonic modes, "Notes slot" is the first slot of a number of consecutive slots. The total number of slots
depends on the range of notes "Range"

(Note 2) This value is normally set to 5 (maximum speed of response) but you can rise it, to save work to the CPU, or to
make more pleasant the sequence in "Radioactivity" mode (to highlight and make more pleasing the sounds produced
made by radioactive isotopes. (it is recommended to use a "polling" of about 200 or 250 ms) 

(Note 3) A sound buffer of 2000 bytes it is normally fine on all computers. If you hear strange noises in the voices, you
could increase this number, to make them disappear. Try at least once, to lower it to a minimum, to hear the kind of
disturbances that occur and be prepared to recognize them. This control should always be at the minimum necessary,
to safely get rid of the noise. The more you increase this number, the more the synth becomes slow in the execution of
notes and commands.

- Slot input to switch to the next voice 
- Slot input to switch to the previous voice

- Slot input to switch to the next line, in the list of chords and intervals
- Slot input to switch to the previous line, in the list of chords and intervals

- Time for the automatic transmission of the chords
- Selection of the list of chords and intervals (a sort of score)
"Edit" opens the folder of the list of chords. Double-click on it, to open the file to edit.

Changes of voices and chords by external applications
External applications (eg Theremino Automation or Theremino Script) can set directly voices and chords
through the Slots: "Voice slot +" and "Chord slot +". The number to be set in the Slot is the Voice or Chord
order number, plus ten thousand. So 10000 means 0 (the first entry in the list), 10001 means 1 ... and so
following.
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Performer variations (play effects)
This page , shows the changes on version 5.1, there may be some additional changes, in the next version,
which will be explained on the download page.

Some of these variations are experimental , we are making adjustments to improve them. In some cases ,
the instructions given in this manual ,  may be inaccurate, please refer to the download page, for more
information.

The adjustments in this panel only act in the " Classic Theremin " mode

No play effects - No effect of changes in the performance.
Volume reduction - This is an effect of automatic "note off", which lowers the
volume when you change  note and restore it, as soon as you stop moving.
Fast Change Volume  - This effect increases the volume changes when you
move your left hand quickly .
Notes Snap - This effect helps the musician , with an algorithm that facilitates
catching the pitch of notes . Effects of glissando and tremolo, are still possible
but the sound is less "whining" and the notes stay in tune .

This image shows the effect of '"Amount" on the 
"Snap" in the notes.

With a high amount, notes are tuned with force to 
the nearest semitone. Unfortunately, under these 
conditions, you no longer feel when you are away 
from the center of the note and it can happen to 
jump on the nearest one, by mistake.

With a low Amount, the help you get is lower, pitch 
and is therefore less accurate. 
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The list of presets

The default voices are only examples, every musician should create his own, best
tailored for the music they play.

The commands to save and reload, rename, and move single items, allow you to
organize items in a workbench called "Default".

Normally only one bank is well organized -the Default bank-, with well planned
sounds, easy to remember, always loaded at the start of the program.

Any sound bank, can be saved to disk and restored, but only the "Default" bank is
automatically loaded at the start. 

A bank contains 129 voices, which normally fall into two main groups, depending
on,  whether or not  they are "Sustained".  Items with "Sustain",  continue to play  indefinitely,  while  the
others, decrease in volume gradually to zero.

The selected item can be changed at will, with the controls on the panels "Main controls", "Oscillators and
Filters" and "Envelopes and Effects" which will be explained in the next pages.

The list of chords and notes intervals

This list defines the valid notes. 

On the image of this example, the notes are limited to a range from C4 to DO9
and chords are set as C, A-, D-, G7, the famous "C harmonic circle" 

The notes are only valid in the range defined by the "range" and included in the chord currently selected.

Starting from the first note of the range, the notes not valid, are "jumped" 

This list is not in use in modes "Theremin classic" and "Theremin Legato", but only in "Theremin pizzicato"
and polyphonic modes.
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Voice modifying - Main controls

Adjust  "Amplitude"  so that  the  VU meter  does not  rise  too much,  in  order  to  avoid  distortion.  This
adjustment also depends on the manner in which the voice is played. In general, if you play in polyphonic
mode, you have to keep a lower level of "Amplitude".

Disabling the polyphony This panel, has no relation to the general modes of operation of the synth, is just
related to the single entry. If you press "Mono", only the last note is played and the previous is immediately
muted.

"Portamento" performs a gradual transition between notes. This parameter affects only those presets that
have at least one oscillator, with portamento enabled.

The "pitch bend" defines the way of action in the "Theremino classic" and "Theremino legato" modes and
the range for the MIDI controller called "Pitch Bend". Compared to the note being played, the tone is raised
and lowered for the number of notes set. If you set 12, the total interval, will be one octave below and one
above. 
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Editing voices - Oscillators and filter

Oscillators and filters are at the heart of the synth.

ThereminoTheremin, can be considered as a hybrid synthesizer. It is based on wavetable/Additive 
synthesis, but includes traditional analog modules (filters, LFOs and envelopes) of a typical subtractive 
synth, as well.  

The filter is a "state variable filter", also a classic, easy to use and a great complement to this synth. 

--------

We will not explain how to adjust these controls, as there is no rule really.  Any combination of adjustments
is valid and a good musician should know how to get the best sounds for his music.
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Changing Voices - Envelopes and effects

The "Envelopes" are normal "ADSR" generators and are used to set the volume of the voice over time, or to
modulate the frequency of the oscillators.

The  LFO oscillators  are low frequency modulators,  that can be used to modulate the frequency in the
oscillators.

Echo and Chorus effects are true classics, perfect for making full-bodied voices. Be careful not to use them
too much, they should just give substance to the sounds and do not act as "environment" effects.

The lack of other filters as Reverb, Flanger is not a defect. In the instrument there should be only the effects
for the individual voices, the environment effects, should be applied in the mixer instead, or in the sound
system, to have more control of the various sounds, in the same environment.

--------

With these controls, there is no rule at all, any combination of adjustments is valid and a good musician
should know how to adjust the voices, for his music.
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The commands on the File menu

The "configuration" includes all adjustments of the configuration
panel (note 1)

Commands to save and restore the Voices banks

Commands to save and restore the individual voices

Images  are  useful,  to  exchange  information  and  advices.
Preferably use images with visible settings.

(Note 1) Reloading a configuration, also restores the selected voice and the list of chords, so that the operation and
sounds are the same, as when the configuration was saved. If the default bank has been changed, then the sound will
be different.

The commands on the Help menu

With  these  commands  you  can   access  to  the  program
documentation.

The  documentation  is  currently  only  in  English,  Italian  and
Spanish.  In  the  future  will  be  translated  into  other  European
languages and Japanese.
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The toolbar

The buttons of the toolbar, allow faster access to frequently used commands.

These commands are a copy of the File menu commands, except for "Run" which is used to enable and
disable communication with the outside world and as a "Panic Button", to stop any sound.

Adjusting the numerical boxes

The  numerical  boxes  of  Theremino  MCA  (and  all  other  System  Theremino  applications)  have  been
developed by us (note 1), to be more comfortable and flexible than the original Microsoft TextBox.

The numerical values are adjustable in many ways:

- Click, hold down the left mouse button and move the mouse up or down.

- With the mouse wheel.

- Using the arrow up and arrow down keyboard keys.

- With conventional methods used to write numbers with the keypad.

- With conventional methods of selection and copy-paste.

Moving the mouse up and down allows large and fast regulations.

The mouse wheel movement, allows convenient and immediate adjustments.

The arrow keys allow fine adjustments, without having to look away from what you are adjusting.

(1) Like all our software, source files are available (Freeware and Open Source licensed under Creative Commons) and
can  be  downloaded  from  here:  www.theremino.com/downloads/uncategorized (Section  "Custom  controls")  These
programs can be used freely in any project, without necessarily naming the source. The "Open" source also serves as a
guarantee, that we have not included malware.
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Playing with isotopes
In the ThereminoMCA application, please adjust the output slots, as seen below.

- Slot to send the counts to (usually towards Thermino_Geiger)

- First slot to send the counts divided into bands

- Number of "Slots" and then, row of consecutive bands

"Counter slot" Used to send the total count to a ThereminoGeiger and make quantitative measurements,
even with a photo multiplier tube, as if it were a normal Geiger tube, but with much higher sensitivity.

"Bins (first slot)" and "Bins (num slots)" are used to divide in zones the spectrum (only the visible part).
The sum of the counts of each area, is sent to a number of consecutive slots, so that other programs can
use these data in real time.

In Theremino_Theremin, adjust the "First slot" to 100 (same number as the "first slot" of ThereminoMCA)

Control  "Amount"  adjusts  the  volume,
compared with the levels of radioactivity.

Set a "Polling" time of around 200 ms and the proper range of notes.

It is possible to change sounds and chords, choose a "Harmonic Circle" or set a time for automatic chords
change "AutoChg(ms)", from about 2000 to 4000mS, to liven up and make harmonious, the boring raw data
produced by radioactive samples .
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Playing the Theremin

The Theremin is a very difficult instrument to play, using "Note snap" and "Volume reduction" modes,
things get a bit easier...

Only  true virtuosos can play  it,  using  the left  hand as  well...  a  tip  for  them:  separate  very  much the
antennas (at least one meter, to avoid interference between the two hands) and make the left antenna,
much larger than what you see in these images

It  is  advisable  to  normal  musicians,
(those  who  are  not  called  Pamelia
Kurstin),  to  reserve your left  hand  to
capacitive  buttons  and  sliders,  much
easier to use.
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Capacitive buttons and sliders

They can be constructed easily by cutting, even by hand, from a sheet of single face copper Vetronite. 

The keys are played on the non-copper side and can be covered with a thin sheet of paper,
printed in color and plastic coated, to give a professional appearance to the keyboard. In this
case, to limit the thickness of the insulation, turn them with copper up .

You can cut the edges with a saw, copper is etched with an utility knife , or eventually, make a
real printed circuit board with all the keys you need, on a single board.

For connections, use regular electric cable, in small diameter and isolated. The length of the wires should
always be kept to the minimum possible, as even the wires are sensitive. Shielded wires cannot be used, as
the electric capacity would increase too. If any part of the instrument, must be very far from the Master,
then you should get to the place, with a serial line and then connect up to ten capacitive keys with a module
called "Servo".

To greatly increase the number of keys,  you can use multiple modules  Servo,  for up to ten keys each.
Beyond a certain limit the serial line slows down. In these case, it is necessary to use more Masters and use,
if possible, 8-bit pins, rather than 16. 

The  capacitive  keys,  can  be  connected  to  a  sampler  as  Theremino  SoundPlayer, sent  to  MaxMsp  or
generate OSC (Open Sound Control) messages, that can be played with any professional tool, via UDP,  local
network  or  the  Internet,  even  on  Mac  OSX  computers,  Linux  or  Android.  See:  www.theremino.com/
downloads/foundations

ATTENTION: To access Theremino's system hardware via USB, you must use the software HAL (Hardware
Abstraction Layer) as well, that can be downloaded here: www.theremino.com/downloads/ foundations

The  capacitive  keys,  can  be  connected  to  a  sampler  as  Theremino  SoundPlayer,  sent  to  MaxMsp  or
generate OSC (Open Sound Control) 
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Tips to avoid feedback, between the antennas 
Antennas lengths and some other random factors, can bring to a situation where both, volume  and notes
antennas, work on the same frequency. This coincidence only rarely happens, but can be very annoying. The
two antennas operating on the same frequency, may interfere with each other, causing interference on the
note, when moving the left hand. 

To avoid this, first of all check the antennas frequencies, in the  HAL program. Double click with the left
mouse button on the line of the first  CapSensor (first arrow on the left). Then do a single click, with the
right mouse button on the second line, named CapSensor (first arrow on the left). Finally, check if the two
frequencies, indicated by the orange arrows on the right, are different (say at least 100 kHz).

To solve a problem of interference, just add a 10 pF capacitor, in series to the volume antenna wire.

This capacitor, sets the volume antenna
to a higher  frequency (it's always better
to have the antenna volume, at  higher
frequency than that of the note). It also
has the beneficial effect of avoiding the
oscillator  volume,  from  causing  noise,
when the antenna is touched.
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Tips to avoid interference from external sources 
The oscillators of the CapSensor, work from 2.3 to 2.6 megahertz. This is an area pretty free from radio
interference,  being before medium and short  waves. Mobile phones, cordless  phones and WiFi  do not
interfere at all. CapSensor cards are also immune from powerful radio emissions, CB and amateur radios. 

The emission power of the CapSensor, is much smaller than that of the Moog Theremin (and therefore  a
lower electrical  pollution to  the surrounding environment),  but  the downside is  that  the oscillators  of
CapSensor,  are  much more sensitive  to noise,  than those of  a  Moog Theremin. There is  therefore  the
possibility that a strong radio broadcaster, who eventually falls exactly on the same working frequency of
one of the two antennas, can cause disturbances. Even a Moog Theremin can be affected, but it would
probably be much less. 

In some rare cases, some little and repeated disturbances were observed, sometimes lasting for hours and
suddenly disappearing. We think there could have been some unusual transmission, not listed in the normal
frequency tables , using the same range we used, but we've never been able to verify this.

In case of problems, you could add a small capacitor in parallel with the pitch antenna. (Between signal
and ground) Only the pitch antenna is important because the noise is minimal and in any case, even if they
are not audible on the volume. 

Adding a pF 2.2, 3.9 pF or pF 4.7 capacitor, causes slight drops in frequency, this way you should find an area
free from interference. Be sure they are pF, if  you make a mistake and use capacitors of nanoFarad or
microFarad, the antenna does not work anymore or loses almost all of its sensitivity. 

Don't worry too much about these observations, in reality it almost never happens, however  it wouldn't
hurt to get a few pF capacitors and prepare a socket for emergency cases, for example when playing next to
an Army transmitter, which transmits on the same frequency of the pitch antenna. 

Solder the cable to the antenna, from below the PCB in
order to free up the male connectors and only use female
connectors  prepared  as  indicated  on  this  page:
www.theremino.com/technical/connection-cables 

------- 
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Tips to avoid note jumping and random noises 

You can have interference from any of these cases: Even minimal movement of metal parts, a wood torsion,
a not perfectly fixed antenna, female connectors not making perfect contact or that turned bad, just moving
your legs under the table or a movement of the mouse, the table twisting or the audience too close. 

HAL application, provides a sort of oscilloscope to test the stability of the oscillators. Please, get used to it
and check that everything is working, making some tests with the HAL. 

Try to move and twist all the mechanical parts, before rely on them. Also, try to keep everything firm and
make sure that the line is free from disturbances, such as in the right side of this picture. A maximum of one
pixel of noise can be tolerated, as the step in the left, before the horizontal part. 

Before making important performances, prepare an adequate workspace and double check, the stability of
all components. 
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Those interested in learning how to play Theremin, should definitely watch this video, from start to finish!
www.youtube.com/watch?v=X-ywH1Vj8_U #

Here you can see the Theremino Synth played by a failed musician! (be good with me, the video serves only
as a demonstration of the features of the Synth):  www.youtube.com/watch?v=QW7XHh9nijo

We will  post more videos soon, on the  Theremino System channel,  that will  show even the individual
voices, the capacitive buttons and sliders.

For information, advice and training on the Theremin, we recommend the fantastic site Theremin World a
mine of useful information, the center of the world for the Thereminist. 

Conclusions
Music, is the best medicine for the soul - Plato

Electronic music, is the best medicine for the Nerd - Livio

Nerd - Person with a predisposition for intellectual research, usually alone, with a much reduced propensity
for socialization. The Nerd, can spend an enormous amount of time in obscure and unpopular activities,
which are  generally  related to very  technical  areas,  or  fiction and fantasy,  with  the exclusion of  more
traditional activities.

That vibrations, be with you!
Max & Livio
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